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From The Editor’s Desk
It gives me great pleasure to announce and welcome you all to the first edition 
of the PhotographyBB Online E-Magazine. As the editor on-board, I’d like to take 
a moment to introduce myself: My name is Dave Seeram, I am a 32 year old 
Digital Photographer and Photoshop® enthusiast, and I am the humble editor of 
PhotographyBB Online.  Some of you may know me through the PhotographyBB.

Welcome to the first edition of the PhotographyBB Online Magazine

I would like to kick things off by dedicating this first issue to some very special people in my 
life. To my beautiful wife Priscilla: Thank you for your encouragement, love, and for always 
being there to offer your sound advice every time I said, “Honey, come take a look at this!”  

To my parents: Thank you for your eternal support, and for raising me to be the person I am 
today... I think I turned out OK! There are many other folks who deserve a dedication, but I’ll 
save those for future issues (trust me, you’ll feel more special that way). 

Since the launch of the PhotographyBB Forums in 2006, the site has grown and evolved in 
several ways. The forums are still THE place to be for photographers and photoshoppers alike; 
mainly at the beginner and intermediate levels of experience. There is a blog style main page, 
and a few other tidbits worth checking out too. During 2007, there was also the major addition 
of the Actions Downloads Page, where visitors can download both free and premium actions 
for use with Adobe Photoshop. Since the inception of this page, the feedback and response 
has been both huge and positive. I would like to thank everyone who has made a purchase 
through the site, and invite the rest of you to try out the free actions that are available there. 
Check back with the page often, as new actions are being added more frequently. 

You can visit the Actions Page here:  http://www.photographybb.com/actions

I would also like to take some time to recognize the contributing authors to this first 
edition of PhotographyBB Online. A special thanks to Kenneth Fagan for his contributions to 
the photography  “how-to” and the “Photography Then and Now” sections, to Victoria Sargysan 
for her tireless support and contributions in magazine format and content suggestion, and to 
Jon Ayres (aka Bossman) for his fabulous street walking photo tour of Moscow. The magazine 
wouldn’t be possible without all of your help, and I thank you for your support. On the same 
note, if anybody is interested in contributing articles, please email me your ideas. For the 
time being, PhotographyBB Online is compiled strictly on a volunteer basis. However, any 
contribution would be of positive value in adding to your own portfolio, experience, and not 
to mention - it’s a cool publication to show off to your family and friends!

The year 2008 is going to be a busy year for us here, and Photography Online is the first 
step. This magazine is shaping up to be a fun and informative addition to our site, and will 
be available for free download on a monthly basis. I look forward to your feedback on the 
magazine and content. We’ll continue to expand the scope of the magazine, providing valuable 
info on photography tips and techniques, Photoshop tools and tutorials, photo explorations, 
and a member spotlight feature. I always welcome new suggestions and recommendations to 
both the forums and the new e-magazine, so feel free to send your feedback and suggestions 
to: magazine@photographyBB.com  

Without further delay, welcome to the first edition of PhotographyBB Online, and enjoy!

Dave Seeram
Editor and Publisher

http://www.photographybb.com/actions
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Photography: Then and Now
Have you ever wondered how photography got to where it is today? Where and 
when did it all begin? I can tell you that it hasn’t always been about high precision 
glass and complicated mechanics. Here is your chance to go back in time and have 
a look at what it was before a half a second was considered a long exposure.

CHANGING TIMES IN PHOTOGRAPHY - BY KENNETH FAGAN

Camera Obscura (Latin meaning dark chamber) 
was the beginning of the birth of photography. 
The Camera Obscura started out as being a fully 

enclosed darkened room with a hole in one wall, and 
on the opposite wall, the image would be reflected 
(upside-down and backwards). This image would be 
created from the light shining through from the outside 
of the Camera Obscura, in through the hole, and onto 
the surface of the opposing wall. Camera Obscura can 
be dated back as far as the 3rd or 4th century BC in the 
days of Aristotle.

It wasn’t until the late 1500’s that a man by the 
name of Daniello Barbaro placed a lens in the hole of 
the Camera Obscura to create a sharper image. The 
Camera Obscura didn’t become portable until around 
the middle of the 17th century, when it was transformed 
from being a large room down to just a simple box. 
It had all the same principals as the original camera 
Obscura; dark, fully enclosed with a small hole at one 
end, and of course, with the addition of the lens. This 
was still the very early stages of photography. There 
was no way of recording the images permanently, the 
reason being the chemicals just weren’t discovered at 
the time to make light sensitive paper and to make the 
image on the paper permanent.

In the 18th century a discovery was made that an 
image was possible to be made on material which was 
first soaked in silver nitrate. This was a great leap in the 
advance of photography, but unfortunately the images 
were only very temporary, and so didn’t last very long.

The first permanent images to be created can be 
credited to Nicephore Niepce, a French inventor of the 
early to mid 1800’s. He made a plate covered with a 
bitumen chemical compound, placed the plate inside 
the camera, and exposed it to the light for about an 
eight hour exposure. The bitumen chemical compound 
he used hardened when exposed to light, and the 
remaining chemicals could then be washed away after 
the exposure was completed. The result of this was a 
negative image (upside down and backwards). He then 
coated the plate with ink and pressed it onto paper, 
creating a print of a positive image. 

The discovery of the benefits of silver nitrate by 
Johann Heinrich Schultz in the 1720’s sparked new 
interest in Niepce’s work. Schultz started experimenting 
with the help of a man by the name of Louis Daguerre, 
who had a similar interest in photography, where 
they worked on developing the silver compounds 
processes. When Niepce died, it was then up to 
Daguerre to continue with the experiments. In the 
following years he discovered that when the silver Kodak Hawkeye Camera
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This article and all images contained are Copyright © and courtesy of Kenneth Fagan, SpikeFoto. http://www.spikefoto.com

(on a copper plate) was exposed to an iodine vapour 
before it was exposed to light, and once the exposure 
was complete, exposing the silver to mercury fumes, 
would then form an image that was still light sensitive. 
To solve this he discovered that placing the material 
in a salt bath, ‘fixed’ the image (“fixed” meaning it was 
no longer sensitive to light). The copper plate with the 
image was then patented as the Daguerreotype.

This  was the beginning of permanent photographic 
images. Many years passed, and the photographic 
process kept on developing. In the 1880’s, George 
Eastmann of New York, developed a dry gel on film. 
This inevitably replaced the plates of the earlier years, 
and had many benefits especially when it came to 
photographers no longer having to move around with 
hazardous chemicals.

Eastmann’s Kodak camera went on the market in 
1888. By the beginning of the 1900’s, it was possible 
that everyone could have a camera, the first one being 
a Kodak Brownie.

From then on, cameras began to come in all shapes 
and sizes, and film types increased as time went on; 
roll film, sheet film, 35mm, etc... Lenses became more 
mechanical, allowing for various different exposures 
on the more advanced models in or around the mid 
1900’s. People could now take their cameras to the 
beach, or anywhere they wished, and send off the 
film to be processed. Film cameras began to be built 
with digitally controlled mechanics, and as technology 
became more advanced with the invention of the CCD 
Chip in the early 1970s, Kodak built the first Mega 
Pixel sensor in the mid 1980’s. These developments in 
digital technology were the beginning of a new era in 
photography. Today, the digital photography market 
has outrun its film predecessor; Film is no longer in the 
demand which it used to be in the 1990’s and before. 
Twenty years (or how about another 500 years) down 
the road, just imagine where photography will be! 

A Compact Agfa Ambi Silette

The Meopta Flexaret TLR made in CzechoslovakiaA Pentax MF 645 Medium Format Camera
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Photography Around the World
PhotographyBB Online Magazine is pleased to launch our first issue with a 
fabulous and stunning photo-tour of one of the most fascinating cities in the 
world - Moscow. Jon Ayres takes us on a streetwalking tour of the city, with some 
interesting historical facts and of course, amazing photos!

Moscow is a lovely and historic city, and it’s a city 
that is easy to get out on your own and safely explore 
the many old historic streets, lovely parks and squares, 
the many old churches, palaces and mansions. There’s 
no better way to see the real Russia than to get out 
on your own and do a little streetwalking, especially if 
you’re a photographer who wants to take some special 
one of a kind type photos. I’m talking about the types 
of photos that give off feelings and full of emotions, 
not the tourist type of stuff that you can only take on 
tours; you can only take excellent photos by getting 
out on your own. None of the “pants on fire” jet tours 
allow for you to take the time needed to take good 
quality photos; you can only do this by getting out 
on your own without some pesky tour guide always 
harping about get on the bus, we have to go to another 
place blab-bla-bla during the whole tour.  On a tour I 
took in St. Petersburg, I thought I would have a heart 
attack, that tour guide was moving so fast.  I have even 

No, no, I know what you’re thinking and that’s 
not what I mean. I’m not talking “those” 
streetwalkers. I’m talking about one of my 

favorite types of tours you can take in Moscow: The 
capital of the Russian Federation and one of the finest 
tours for the photographer.  Not only is it the finest 
types of tours for a photographer, but for anybody else 
for that matter to take. It is one of the least expensive 
tours, completely free unless you choose to go inside 
a museum or two. Sure, I know it’s only natural to want 
to see the major tourist’s sites when you decide hit the 
road and come to Moscow.  Famous places like the 
Kremlin, Red Square, St. Basil’s Cathedral or the Pushkin 
Museum of Fine Art, but there is so much more to see 
than just the major tourist sites which tend to have 
something of a tourist trap flavor to them now, with 
so many people trying to sell things at tourist prices 
which we all know that means selling things at least 
100 times more that they are really worth.  

STREET WALKING IN MOSCOW - BY JON AYRES
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better.  Both cities are very nice, but I like Moscow better 
because it is a lot older and I love history.  In a number 
of Moscow’s historic areas, you will find pedestrian only 
streets like Old Arbat.  Old Arbat is a pleasure to walk 
down and see the interesting sites and shop in some of 
the real stores and Lavrushinsky pereulok, a lane which 
makes streetwalking photography a true pleasure.  

When you walk down one of Moscow’s historic 
streets such as one of my favorite streets, Bolshaya 
Ordynka, you can not help but feel as if you have 
stepped back into a bygone era.  For example, here on 
Bolshaya Ordynka (street) you can find many historic 
buildings that are overlooked by most tourists such 
as the Marfo-Mariinsky Convent, founded by Grand 
Duchess Elizabeth Feodorovna who was both aunt 
and sister in-law of Tsar Nichols II, the last Russian tsar.   
This convent is only one of the many sites found on 
Bolshaya Ordynka, and Bolshaya Ordynka is only one of 
the many historical streets to be found in Moscow with 
interesting mansions, palaces and churches built in 
the 1500’s, 1600’s, 1700’s and 1800’s that many tourists 
never get to see, let alone even know about.  

The history of Moscow officially dates from 1147 

when Prince Yuri Dolgoruki founded a settlement here 
named after a river.  Recent archeology discoveries now 
push the date of inhabitance back to the year 850.  One 
of the reasons tourists travel to Russia is that Russia 
stands out from the rest of Europe and as a matter of 
fact, the rest of the world, because during the rule of the 
communists, Russia was a country closed to outsiders 
(people outside the Iron Curtin).  Now that communist 
rule has ended, tourists from all over the world flock to 
Russia each year to see a lovely part of the world that 
was closed to them for so long. However, few of these 
tourists bother to get out on their own by themselves 
and see the real Moscow - instead choosing to take 
pre-booked tours and that really is no way for the 
photographer to get good photos that express feelings 

seen tour buses take off and leave tourists on some of 
the Golden Ring city tours I have been on.  What many 
people do not know was that the city of Moscow has 
decided to make tourism a major source of income 
for the city, from 5% at present to 20% of the city’s 
revenue and compete with Paris and other European 
cities, which Moscow can do very well.  Moscow has 

rebuilt the Tsaritsyno palace ruins of Catherine the 
Great and there is talk that Moscow will rebuild the 
wooden palace of Kolomenskoye in order to compete 
with St. Petersburg for tourists.

Since the end of communist rule in the early 
1990’s, tourism has become one of the major money 
making industries in Russia.  The cities of Moscow and 
St. Petersburg are now considered to be two of the 
top tourist destinations among Asian and European 
tourists and the competition is heating up between 
the two cities.  Only in the last couple of years have 
Americans and Canadians starting to come here to 
see a fascinating part of the world that was closed off 
to foreigners for so many years.  I personally prefer 
Moscow to St. Petersburg, but it really depends on what 
your interests, likes, and dislikes are as to which city is 

Walking down the Mokhovaya St. one can see a splendid palace in 
back of the Kremlin and it is one of my favorite mansions in Moscow, 
The Pashkov Manor.  The complex consists of the mansion, stables, 
manege, servant’s quarters and church.  Legend says that Pashkov 
who was in the military got upset about  a demotion he received from 
the Tsar, so he decided to build his mansion across from the Kremlin 
and to add insult, the back of his mansion faced the Kremlin.  Today 
the mansion houses the RGB which is the largest library in Europe (the 
second in the world after the US Library of Congress).

Old Arbat Street is a picturesque pedestrian street.
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and bus/trolley map.  Now on each map, mark where 
you will be staying, the hotel, hostel, where ever you 
will be staying, mark it on each map with a red circle.  
On the street map/metro map, mark the nearest metro 
station and bus stop closest to your hotel or wherever 
you’re staying, and the bus, tram and trolley numbers.  

That way you will always be able 
to find your way back to where 
you’re staying with no trouble 
at all.  Its easy to get lost if your 
careless, I do it all the time myself.  
I fall asleep on the subway and 
miss getting off where I should; 
the bus maybe crowded and in 
winter the widows fog up and I’ll 
miss my bus stop. So download 
and print out a few maps of 
Moscow, mark on them where 
you will be staying, then use a 
highlight marker and highlight 
the route you will be taking and 
you have just developed your own 
street walking tour.  Easy wasn’t 
it?  Have I ever gotten lost?  Well, 
lets just say I’ve gotten turned 
around a few times until I found a 
subway or metro station.  Always 
look for the nearest metro station 
if you get lost.   

Moscow has a great public 
transport system, it’s not perfect, 
some bus drivers are not always 

nice, but that can be expected in any city after having 
to deal with a few thousand fools every day.  When you 
check into your hotel, ask and see if they have a free 
copy of the city of Moscow’s tour guide, The Official 
Tourist Guide, absolutely one of the best tour guides of 
Moscow, some great maps in it and I would download 
a copy of it from the city of Moscow’s web page (I have 
a link to it at the end of this article). Each metro station 
and subway car has a metro map.  The stations and 
metro cars are all well marked with signs telling you 
which train to take or the route of the metro you are 
on, in order to reach a certain station or line and signs 
telling you what buses run at each metro platform 
entrance/exit.   Each line has its own color; if you have 
downloaded a metro map then you can easily see how 
to get to where you want to go.  You can also pickup a 
free metro map at most hotels and they are often given 
out to passersby’s at various metro stations, keep one 
with you along with your other maps.  If you want to 
take your own walking tours, the wise plan their routes 
out first, because in this concrete jungle, you can get 
lost very easily if you get careless.  So plan out what 
you want to see and the routes you want to take and 
you’ll have a great tour that very few other tourists get 
to have or see of this fantastic city.  

on these rush rocket job tours.  Most tourists choose 
to rely on organized pre-booked tours that rush from 
major site to major site for many reasons.  Some want 
to see as many of the major important sites as they can 
on the limited time they have here, others are afraid 
that because they can not speak Russian that they 

can not get out on their own which is not neccesarily 
true; they can get out on their own very easily if they 
want to.   I see it each spring and summer, bus loads 
of tourists rushing from site to site as if they were in 
a rocket!  Taking pre-booked tours are fine, you can 
easily see all the major sites very quickly, but there is 
so much more to see than just the major sites.  What I 
call the real Russia, the real people, real culture and real 
history and it’s very easy to see if you are willing to get 
out on your own and do some streetwalking.  How do I 
street-walk you may ask as if you do not really already 
know?

 First thing, if you’re considering coming to Moscow, 
take time and research the city beforehand instead of 
just popping into your local tour agency and saying I 
want to go to Moscow, then settling on one of the rush 
job tours that most travel agents try and push.  Plan out 
what you want to do and see and where you want to go.  
This is important for several reasons, especially if you’re 
a photographer.  Moscow is a big city and I do mean 
BIG - the largest city in Europe.  I’ve been living here for 
5 years now and I’m still making new discoveries and 
finding new things that I never knew existed here.  You 
should download a street map, metro (subway) map 

This ancient little street has an atmosphere of the middle-ages - it sparkles with the golden domes 
of churches of which there are more than on any other Moscow street. Its name comes from one of 
these churches - the church to St.Varvara.  In this photo, you can see the Old English Court at No. 4. 
which is one of the oldest stone buildings in Moscow.  Next are the remaining structures of Znamensky 
monastery and then Church of St. Gorge in the distance.
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bones from slipping on ice can be risky, then you 
might want to only consider coming here in the spring, 
summer or early fall.  Early fall is a good time to come, 
the maple leaves are changing and prices have begun 
to fall due to the off season.  Moscow is a lovely city 
that has a lot to offer year round, but you should think 
about what time of year is best for you. 

Can you get out and do some streetwalking and 
be safe?  Sure you can if you are careful; Moscow is one 
of the safest cities in Europe, but it is not crime free.  
Be careful if your out late and not many people are 
around.  The secret to taking safe streetwalking tours 
is always being aware of what is going on around you 
and making yourself a tough target.  Do not take risks, 
put your camera in your camera case while shopping 
with it, and if you’re out late and not many people are 
around, do not walk around with your camera hanging 
around your neck (sure sign that you’re a tourist) and 
a target.  Do not get me wrong, I walk around Moscow 
all the time with a camera around my neck, but there 
is a time and place to do this and likewise a time and 
places not to do this.  Just use your common sense!  

What time of year is the best time to come to 
Moscow?  That really depends on your preferences.  In 
spring and summer the weather is nice, but a little on 
the warm and rainy side, this time of year is considered 
the tourist season, so prices will tend to be higher.  Fall 
and winter can be nice and lovely, but Russian’s winters 
can also be brutal, so make sure you have good warm 
clothing and good warm boots that will not slip on 
ice.  If you come from a part of the world where it only 
snows heavily once in a lifetime and are not used to 
walking on ice without busting your you-know-what, 
then winter may not be the best time to come here. 
I know because I come from southwest Georgia and 
foolish me, I bust my butt on ice here every winter.  I 
even broke my arm last winter when I slipped on ice 
because I did not watch where I was stepping.  Thank 
goodness I know how to pick out a good camera that 
does not break when I slip on ice.  My arm may break, 
but not my camera!  That being said, winter time is a 
lovely time of year. The old churches covered in snow 
are beautiful and to watch the pretty Russian girls ice 
skating is a pleasure.  Also, since fall and winter are 
the off tourist seasons, prices will be lower than they 
are in spring and summer.  If you’re looking to save 
money, then early spring and mid fall is the best time 
to come - the weather is not too bad and prices are 
very reasonable before they get higher for the tourist 
rush.  One thing you should take into consideration is 
your age.  If you’re a part of the older generation, not 
as strong as you used to be, tire out easily or if broken 

Just me riding on a tram, one of the good ways to get around Moscow.  
Public transport in Moscow is good, but try to use it outside of the rush 
hours when people are going to work, lunch and returning home. 
Other times are not so bad as you can see in my photo.

Kazan Cathedral located in Kolomenskoye Park, built by Tsar Alexei in 
1649-1653 to commemorate the centenary of the capture of Kazan by 
Ivan the Terrible, is of typical 17th century style. Atop the arched first 
story sits a solid four-walled structure, crowned by five cupola-topped 
cylinders.  Kolomenskoye Park has many old and historical buildings, 
not to mention a lovely overlook view of the Moscow River and nice river 
walk trail.  Depending on the time of year, you may be able to pick a few 
fresh apples in an apple orchard next to the park as you walk through 
the orchard, very tasty.
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you should take out your camera and when you should 
leave it in its case.

There are two types of churches in Russia: Churches 
that are still official churches of the Russian Orthodox 
Church (All Russian Orthodox Churches are official 
churches to the Russian Orthodox Church, but some are 
inactive and considered museums). For the churches 
which are still active and hold religious services, taking 
photos inside these churches are not always allowed, 
nor inside certain convents or of the female nuns.  
Taking photos in these cases are not permitted.  For 
example, at the Danilov Monastery where the Patriarch 
of the Russian Orthodox Church lives, taking photos 
inside the monastery is not allowed and the Cossack 
guards will stop you from taking photographs.  Outside 
is fine, and you can take all the photos you want to take, 
but inside is not allowed. 

In churches, monasteries and convents which are 
considered museums or no longer active officially, 
you can take photos inside.  Sometimes a church 
or monastery will allow photos if you buy a permit 
which costs maybe $1.00 or $1.50, for example the 
Novodevichy Convent which is now part of State 
Historical Museum and founded in 1524 is a good 
example.  Buy a photography permit for $1.50 and take 
all the photos you want inside the convent.  Remember, 
you are guest in another country, always respect the 
beliefs and customs of your guests.

  Just what can you see by street walking? A little 
of everything and a lot of one of a kind things you 
will find nowhere else in the world.  Moscow is a city 
where it really does not matter where you go, you can 
always find something interesting and something 
going on.  The historic district of Moscow is generally 
centered a round the Kremlin, the Kremlin being in 
the center of it all.  Not everything historic is located 
around the Kremlin, but a lot of it is and this helps to 
make many streetwalking tours very easy.  Streets such 
as Nikolskaya with its Royal Print Yard where the first 
Russian book was printed in 1564 all end around the 
Kremlin.  Most of Moscow’s historic streets are within 
walking distance from the Kremlin and Red Square. I 
have provided links (at the conclusion of this article), 
which show Moscow’s famous and historic streets in 
detail so you can plan out where you want to go and 
how to get there.

The best streets in Moscow to explore (to me) are, 
Tverskaya Street (sometimes referred to as Paris in 
Moscow because of all the cafes, restaurants, hotels 
and sites located on this street).  This is the main street 
of Moscow and it has existed since the 1100’s.  My 
favorite walk is from Pushkin Square to the Kremlin.  
What I find so interesting about Tverskaya Street are its 
side streets.  Just glance down them when you come 

Rules about photography in Russia: Rules about 
photography are generally the same in every country, 
in that if it’s on a street and in public view, it can be 
photographed.  But be forewarned, it is illegal to 
photograph inside subway stations.  In St. Petersburg, 
this law is strictly enforced, but in Moscow it is often 
overlooked as long as you’re not blocking traffic or 
causing and obstructions, especially in the subway 
stations of the circle ring which are like miniature art 
museums in themselves.  Photographing embassies 
are not well thought of by the security staff, but if the 
embassy is located in an old mansion, you generally can 
photograph it from a distance with no trouble.  Russia, 
like most other countries,  charges for photography 
permits. Museums all like to charge for the right to take 
photos and some museums like the Diamond Fund 
where Russia’s Crown Jewels are kept will not even 
allow cameras inside.  Do not try and even use a tripod 
at Red Square, Alexander’s Garden or Tsaritsyno, or 
police may ask to see your professional photographer’s 
permit (a couple of hundred dollars permit).  Also, try 
not to be obvious with your photography when you’re 
the only one taking photos.  By this I mean if you’re in a 
park taking photos and you’re the only photographer, 
and a policeman walks by, he will not notice you or 
bother you.  But start tying to take his photo and you 
can pretty well believe he’s going to stop and ask you 
some questions.  Use your common sense; know when 

Entrance to the Danilov Monastery, which is now the residence of the 
Patriarch of the Russian Orthodox Church Patriarch Alexei II.  No photos 
allowed inside the monastery.
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to them and you will notice old churches, old boyar 
mansions, small city squares, this is the real Moscow, 
the main street of Moscow.

Another of my favorite streets is Lavrushinsky 
pereulok where the famous Tretyakov Gallery is located.  
This area is in walking distance from Red Square, just 
walk across the Bolshoy Muskveretsky most (bridge) in 
back of St. Basil’s Cathedral, go down Bolshoy Ordynka 
which is another fantastic street and another of my 
favorites, turn right when you reach Bol Tolmachyovsky 
pereulok and you can not miss the gallery, Lavrushinsky 
pereulok is a great photographing area.

Brief Historic Fact:

Church of Christ the Savior as seen from 
the entrance of Alexander’s Garden Square 
which is located at the bottom of the church. 
The Cathedral of Christ the Saviour is the 
largest Eastern Orthodox Church in the 
world. It is located in Moscow, on the bank 
of the Moskva River, a few blocks west of the 
Kremlin.  Construction started in 1839 and 
was consecrated on the very day Alexander III 
was crowned, on May 26, 1883.  After the 1917 
Revolution and, more specifically, the death of 
Lenin, the prominent site of the cathedral was 
chosen by Stalin as the site for a monument to 
socialism known as the Palace of the Soviets.  
Stalin ordered the Cathedral of Christ the 
Savior to be dynamited and reduced to rubble. 
It took more than one blast to destroy the 
church and more than a year to clear the debris 
from the site. The original marble carvings 
were preserved and are now on display at the 
Donskoy Monastery.  The palace of the Soviets 
kept sliding off into the Moscow River and this 
frightened many people who thought God 
had cursed this site because his temple was 
destroyed.  Finally Khrushchev ordered work 
stopped and a swimming pool to be built 
instead after Stalin’s death.  With the end of 
the Soviet rule, the Russian Orthodox Church 
received permission to rebuild the Cathedral 
of Christ the Savior in1990.  A building fund 
was started in 1992 and donations began to 
pour in from ordinary citizens in the autumn 
of 1994.  The church was completed in 2000. A 
pedestrian bridge across the river, leading to 
the church was built and is a nice location to 

A view of the Kremlin from Bolshoy Muskveretsky most.
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Bolshaya Dmitrovka runs parallel to Tverskaya 
Street from Okhotny Ryad to Strastnoi Boulevard. 
Members of Moscow’s high society used to settle here, 
and at one time the street was known as Dvoryanskaya 
Street (Nobility).  Since this street runs parallel to 
Tverskaya, you can walk down Tverskaya and return on 
Dmitrovka.

Bolshaya Nikitskaya Street, is another of Moscow’s 
interesting streets with many sites to see including the 
Church of the Great Ascension, which was the site of 
Pushkin’s marriage to the beautiful Natalia Gonchareva 
on February 18, 1831. A stone church was first built on 
this site in the 1600’s at the request of Peter the Great’s 
mother, Tsarina Natalia. 

Varvarka (St. Barbara) Street is one of the oldest 
streets in Moscow, dating back to the 1300’s, and this 
street is perfect to visit while your visiting Red Square.  
The street runs right to St. Basil’s Cathedral, and you 
can walk down Varvarka and see some of the oldest 
buildings in Moscow, then swing over and walk down 
next to the old Kitay-Gorod walls or as it is sometimes 
called the China Town Walls.  These walls surrounded 
the merchants village next to the Kremlin, then turn 
right and you’ll be walking back toward Red Square.

I also love Moscow’s parks and squares.  Moscow 
was a city of parks, but sadly real estate prices have 
risen so high that many of Moscow’s parks are slowly 
being destroyed.  Moscow still has many parks at 
present and I always love to stop in one during spring 
and summer and rest awhile, have a cool Russian beer, 
maybe a hotdog or stuffed baked potato, watch the 

world go by, and of course take a few photos.  The most 
famous square in Moscow is Pushkin Square, where if 
you’re going to meet somebody, you can arrange to 
meet them in front of the statue of Alexander Pushkin, 
the famous Russian poet.  I have met a few fellow 
Americans here myself, who had read my articles and 
emailed me.  I would meet them there and show them 
around a little.

Two of the largest parks in Moscow are Tsaritsyno 
and Kolomenskoye.  In the southern part of Moscow, 
you will find the State Museum-Reserve Tsaritsyno.   
Tsaritsyno is the largest museum-reserve and historical 
and cultural monument of the federal level in Moscow, 
occupying over 700 hectares. 

 Kolomenskoye Park is another of my favorite parks 
to walk around in, many old and historic buildings from 
all over Russia are either located originally here or were 
moved here and rebuilt in order to preserve them.  
Located on a high bluff overlooking the Moscow River, 
many historic sites can be found here including Stone 
Age stone carving on the river bank.  Dating from the 
14th century, Kolomenskoye was the family estate of 
the Grand Dukes of Muscovy and later the Tsars of 
Russia.  The luxurious chambers of Vasily III 1479-1533, 
the Grand Duke of Moscow was burned down during 
a raid by Khan Mukhammed Girei I of Crimea. In 1532, 
Vasily III built the church of the Ascension in the village 
of Kolomenskoye, to commemorate the birth of his son 
Ivan IV.  It was the first known stone church built in the 
Russian kokoshnik, or tent style.  Ivan IV the Terrible 
1530-1584 lived here as a child, and later with his first 
wife Anastasia.  Unfortunately, the wooden palace 

Pushkin Square on Tverskaya Street is the famous meeting place.
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of Tsar Alexei Mikhailovich, a unique masterpiece of 
Russian architecture built in 1667-1668 by Semen 
Petrov and the serf carpenter Ivan Mikhailov, did not 
survive. This beautiful palace, considered by its Russian 
contemporaries to be the “Eight wonder of the world”, 
consisted of a large number of buildings interconnected 
by passageways.    The original palace ensemble must 
had been very impressive with all its towers, cupolas, 
Kokoshniks, ogee-shaped roofs, spires, globes, gilded 
double headed eagles.  The young Peter I the Great was 
taken to Kolomenskoye during the Streltsy riot of 1682. 
Later, as tsar, he returned several times. Partly because 
of changes in taste, and because the capital had been 
moved from Moscow to Saint Petersburg, the palace 
was neglected and the old wooden structure became 
unsafe for living. In 1769 Catherine II ordered it to be 
taken down.  There is talk now in Moscow that the city 
of Moscow will be rebuilding this palace as the have 
rebuilt the palace of Tsaritsyno.

I have mentioned only a few of the many 
fascinating streets to explore in Moscow; it would take 
writing a book to name them all!  So why not break out 
your hiking shoes when you visit Moscow and spend a 
couple of days seeing the real Moscow, the real Russia 
and her people that most tourists miss out on seeing.   
The key to making and taking a safe and productive 
street walking photography tour, is planning.  

Hopefully I have shown you enough examples 
to wet your appetite a little.  Moscow and Russia will 
remain a mysterious place to most of us Westerners as 
it was closed off to most of us for so many years.  It really 
makes no difference what time of year you choose 
to come to Moscow, each season has it own unique 
qualities. Moscow is a city unlike any other city and is 
truly a photographer’s dream city. So come here and 
find out for yourself just what you have been missing 
out on - Taking your own Moscow streetwalking tour 
will be a decision you’ll never regret making.

Helpful Links for Planning Your Own Moscow 
“Streetwalking Tour”
  
Moscow Times Guide to Moscow and St.   
Petersburg
http://guides.moscowtimes.ru/travel/index.
php?r1=tr&r2=tmt&r3=menu

You’re Private Guide in Moscow, Famous Moscow 
Streets:
http://www.guideinmoscow.com/site.
xp/050055056.html
http://www.guideinmoscow.com/site.xp/057054.
html

WikipedA:  Streets in Moscow:
http://en.wikipedia.org/wiki/Category:Streets_in_
Moscow

Moscow Traveler’s English version of the 
YellowPages:
This is one of the best sites for information on finding 
where places are, their addresses, phone numbers, 
web and email addresses.  
http://www.infoservices.com/moscow/2527.htm

The City of Moscow’s Website: 
If it is not in English, you can choose English on 
the left of the web page.  This web page has one 
of the best Moscow travel guides there is that you 
can download and printout the maps and plan your 
walking tours.
http://www.moscow-city.ru/?lang_char_id=en

This is a link to the guides you can download, though 
dated, they are still wonderful for the do it yourself 
explorer, especially The Official Moscow Tourist 
Guide. 
http://www.moscow-city.ru/download.phtml

A Word From the Author:
My name is Jon D.  Ayres and I’m originally from Albany, GA in the US.  I first came to Moscow, Russia in August 2003 and feel in love 
with the city and I have been here ever since.  I consider Moscow as much my hometown as I do Albany. Photography, writing and 
history are my hobbies along with shooting, hiking, camping, fishing, hunting and walking.  I enjoy taking walks around Moscow 
and live next to a nature preserve in the southern part of Moscow where I enjoy taking walks and photos.  In Moscow, I have taught 
English, business, history, literature among other things.  

I have been involved in writing, digital art and photography for over thirty years and I am a published author having several articles 
and photos published.  I have owned and used many cameras, including a Canon SLR, Polaroid and more digital cameras than I can 
remember.  I’m a firm believer in post processing and have been using Photoshop since the first version came out.  You can find 
examples of my digital art and photography at the following sites:

• http://www.redbubble.com/people/bossman • http://www.featurepics.com/Authors/Images6269.aspx
• http://www.eyeoftheart.com/JonAyres  • http://s28.photobucket.com/albums/c226/wummis/
• http://www.fotothing.com/JohnnyReb/
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Photography 101
Each issue of PhotographyBB Online Magazine is going to bring you helpful tips 
and tutorials on how to get the most of your digital cameras and equipment. 
We’ll cover camera techniques, principals of photography, digital photography 
issues, and how to get the most from the dreaded manual-mode! 

UNDERSTANDING F-STOPS - BY KENNETH FAGAN

First of all, before I begin, I will define some terms 
which I will be using in this article, to give you a 
better understanding of their meaning:

Diaphragm: The device in the lens which controls the 
amount of light entering the lens.

F-stop: The size of the opening in the diaphragm of 
the lens, each different f-stop allows a certain amount 
of light to enter the lens.
 
Depth of Field (DOF): The amount of area in or out of 
focus in an image.

Aperture: The opening in the diaphragm which allows 
the light to enter.

Shutter Speed: The length of time the shutter remains 
open in your camera.

Exposure: The aperture and shutter speed combined.

So now, once you understand the different terms, 
on your camera each f-stop will be represented as a 
number, depending on your lens, and they can vary 
greatly.

The smaller the number the larger the aperture, 
or opening. Each f-stop increases or decreases the 
amount of light entering the lens by a magnitude 
two times. These f numbers increase by the following 
increments: 

f1.0, f1.4, f2.0, f2.8, f4.0, f5.6, f8, f11, f16, f22, f32, 
f45, f64, f90

For this tutorial, let’s begin at f5.6 and go up as far as f45. 
Remember that as the size of the number increases the 
smaller the aperture in the diaphragm is, and therefor, 
the less light is being let into the camera.  So, f5.6 allows 
x2 as much  light enter the lens as f8, this means that f8 
allows x2 as much light in as f11, and so on.

Each f-stop (if your camera/lens allows) can be divided 
into 1/3 or ½ stop increments, which are as follows: 

(1/3 stops): f5.6, f6.3, f7.1, f8, f9, f10, f11, f13, f14, 
f16, f18, f19, f22

(1/2 stops) f5.6, f6.7, f8.0, f9.5, f11, f13, f16, f19, f22

The largest f-stop on your lens (in this example) f5.6, 
will be allowing the most light into the camera (since 
the apateure opening will be larger), and you will also 
have the shallowest depth of field. This means that 
when you are focused on the main subject you want 
to photograph, the objects on front or behind it will 

Are you having trouble understanding the whole concept of f-stops?  If you are, then you are not alone. When you buy a shiny 
new SLR for the first time, there is a bombardment of technical information for you to get your head around. In this article I will 
explain what you need to know in order to get an understanding of f-stops. It takes time and practice to get to grips with which 
f-stop to use for the type of image you want to create.
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remain out of focus, depending 
on how far they are from the main 
subject. As the f-stops decrease 
(remember, the f numbers get bigger 
but the aperture size decreases), 
the surrounding objects become 
sharper. 

Let’s have a look at a real-world 
practical example to get a better 
understanding of this. Take two 
similar objects place them on a 
table, one being about 12” on front 
of the other, making sure that they 
are both visible in your viewfinder. 
Mounting your camera on a tripod 
would be of great benefit to keep 
the camera still and in the same 
position throughout. Once you 
have all the preparations complete, 
focus on the front subject for each 
shot. Set your camera to an aperture 
of  f5.6 and do a light reading to 
determine the shutter speed (the 
built in light meter in the camera will 
be able to do this for you). If there is 
not enough light at this point, you 
can increase the shutter speed time; 
conversely if there is too much light, 
you can decrease the shutter speed 
time.

To demonstrate the effect of f-
stops affecting the depth of field 
(DOF) you will need to take about 
5 photographs of the subjects. The 
first image should be taken at f5.6,  
the second at f8.0, the third at f11, 
fourth at f16, and fifth photo at f22.

You will notice that as you decrease 
the f-stops the shutter speed 
will double, for instance if you 
photographed the first image at 
1/500th/sec. f5.6, for your second 
image (f8.0) the shutter speed will 
have doubled to 1/250th/sec, this is 
because the size of the aperture has 
decreased by half, f11 would end up 
1/125th/sec, f8 1/60th/sec.

 A camera (held by hand) at 
1/60th will be shaky, unless you have 
a steady hand, so if you can avail of a 
tripod I would recommend you use it 
for more clear and sharp images. For 
each of the photographs, note the 

Photo taken at an f-stop of f5.6

Photo taken at an f-stop of f8

Photo taken at an f-stop of f11

Photo taken at an f-stop of f16

Photo taken at an f-stop of f22

A Real World Example:
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f-stop used and the shutter speed. 
Once you have photographed the 
subjects at the 5 different exposures, 
load the images up onto your PC or 
Mac, or if you used film, use up the 
roll before you get them printed.

Once you are able to view the images 
and identify which image goes with 
which exposure (which you noted 
earlier in the project!), you will 
notice a slight difference between 
the first image (f5.6) and the second 
image (f8) having the background 
subject more sharp than that in the 
first image. Then compare image #1 
to image #5 (f22), where both the 
subject in the foreground and the 
background are sharp.

To get the full benefit of f-stops and 
DOF (Depth of Field) you will need to 
understand the basics of the built in 
light meter in your camera: 

In most digital and film SLR’s, the light 
meter is represented as the following 
on both the LCD screen and when 
you look into the viewfinder:

   -2..-1..{   }..+1..+2 
•

The ‘•’ represents the current light 
reading. If it is positioned in the 
centre ‘{ }’ it means that the camera 
is set to the correct exposure for the 
given amount of light. Should the ‘•’ 
be positioned under the -2, -1, +1, 
+2 this means that the camera is set 
one or two f-stops under or over, 
for the ideal exposure. So when you 
are out photographing, for instance 
if you have your camera set to f11 

and the light meter marker is at -1, 
change the f-stop to f8 to open up 
the aperture, likewise if the marker is 
at +1, change the f-stop to f16. 

Additionally, it is also good practice  
to take photographs one stop under, 
one stop over,  and one  at the correct 
exposure This way,  you can view the 
results and see which image has the 
best exposure on screen or when 
printed; this is called bracketing. 
Bracketing gives you some lee-way if 
the lighting conditions are tricky or 
you are using the flash. Some camera 
models have an “auto-bracketing” 
mode, which automatically takes 
3 (or sometimes even 5) photos at 
various f-stop intervals, so that you 
can later choose the photo with the 
most pleasing exposure.

It should also be noted that the 
built in light meter in your SLR is 
not accurate 100% of the time, as it 
generally just takes an average light 
reading. Hand held light meters are 
much more accurate as you can do 
readings on various areas on your 
subject.

To get more in depth on the subject 
of light readings, the two small 
dots between each number ( -2..-
1..{}..+1..+2) represent 1/3 stops. If 
there was only one dot between 
each number, this would mean that 
they were representing ½ stops.

I hope that this article has shed 
some light (no pun intended!) on 
the subject of f-stops and exposures. 
It takes time and practice to fully 
come to grips with lighting, shutter 
speeds, depth of field etc... Many 
people might think that it is not very 
important to know these things (since 
your camera may have a full-auto 
setting). However, in the long run, as 
you get more and more accustomed 
to using the manual settings in your 
camera, the more you will enjoy the 
wonderful art of photography. The 
results won’t come immediately, but 
keep your mind on the task at hand 
and you might just be impressed 
with what you come up with!

“...it is also good 
practice  to take 

photographs one 
stop under, one 

stop over,  and 
one  at the correct 

exposure. This 
way,  you can view 
the results and see 

which image has 
the best exposure 

on screen or 
when printed...” 
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Unleashing The Power of Curves
In each issue of PhotographyBB Online Magazine, we’ll take an in depth look at a 
specific function which can be accomplished with curves. We’ll go through real-
world examples and applications that will add to your knowledge and show all 
that can be accomplished with this “perfect” tool! 

Often our images look more flat on a computer 
screen, than how we remembered them to be in real 
life. A lot of this is due to the limitations of digital 
photography when it comes to camera sensors, 
exposure settings, and in-camera image processing. 
Once we finally get the photo onto our computer, the 
results are sometimes left looking “flat.” Often, a quick 
adjustment to the contrast in your photo can bring 
back the “vividness” of the photo, and really add some 
punch back into it. 

But First, Some Theory:
Contrast is basically the relative difference between 

light and dark (highlight and shadow) areas of an 
image. So what does this mean, and how can I achieve 
better contrast using curves? Let’s begin with a basic 
understanding of curves and contrast. If you glance at 
the image of the curves dialog box off to the right, we 
can have take a closer look at some of our options. 

Curves gives us control over many things in our 
image, which is why we can accomplish so much with 
just this one tool. However, with regards to affecting 
image contrast, we’ll just examine the necessary 
options for the time being (we will look at all of the 
curves options throughout our series on curves 
in each issue). The first thing you’ll see is the main 
graph representation of the curves distribution (that 
diagonal line running through the graph), and the 
histogram of your image greyed out underneath. I’ll 
get into histograms shortly, but I’d like to first focus on 
what the actual graph represents. If you notice along 

the horizontal axis of the graph, you’ll see the word 
“Input,” and along the vertical axis you’ll see the word 
“Output.” In RGB image mode, these two axis’ represent 
the value of light, ranging from a minimum of zero, to 
a maximum of 255. You can also change these scales 
to represent ink values (which would range from 0% 
being white, to 100% being black) if you are primarily 
working with images for print. For this series, we’ll be 
working with the light values in RGB mode, rather than 
ink values in CMYK mode (which you can change back 
and forth between, using the Curve Display Options tab 
a the bottom of the Curves Dialog box). Each shade of 
every color in your image is made up of 255 brightness 

CONTROLLING CONTRAST WITH CURVES - BY DAVE SEERAM

Curves have long remained a mystery for many photoshoppers, as they can be a bit intimidating and often 
don’t produce desirable results when you just experiment with them. It’s not like a linear slider you can move 
back and forth as you watch the changes. Curves are a vastly more complicated tool, but quite arguably the 

most effective tool in Photoshop. What many Photoshop users may not realize, is that the majority of standard image 
enhancing from brightness, contrast, saturation, color correction, and even sharpening can all be accomplished with 
the curves option. In this first issue, we’ll take a look at the most common application of curves, which is contrast 
adjustment.
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values or “intensities” of light. So any color in your 
image has it’s own light intensity somewhere between 
0 and 255, and curves give us control to change that 
brightness, for any color in our image. When we work 
with curves to adjust contrast, we are only going to be 
concerned with your image’s lightness or luminance 
values, rather than individual colors. 

That being said, the line down the diagonal of the 
graph is showing us the input value of light, versus 
the output value. Along the horizontal axis we can 
see the lightness values ranging from pure black on 
the left (0 value of light) all the way over to pure white 
on the right (255 value of light). This represents the 
shadows (or darks) in your image, all the way through 
to the midtones (the middle area of the graph), to the 
highlights (lights) in your image. Basically, the bottom 
graph represents what the lightness values in your 
image are, and the vertical graph represents what they 
will be when changes are made to the curve. Now that 
I’ve said all of that, I’ve probably just confused everyone 
more than helped them! It’s all going to become very 
clear in a moment, I promise!

  Let’s have a look at an example:

By clicking on the white and black tabs on the 
bottom of the graph, you can drag them across the 
graph to change their values. What we’ve done in the 
above example is increased the contrast in our image. 
Recall that contrast is the difference between dark and 
light, and higher contrast would be a greater difference 
between dark and light. So looking along the bottom 
of the graph, by dragging those black and white sliders 
inwards, we are darkening the shadow ranges, and 
brightening the highlights (albeit, in a curve like this, 
you will lose detail in your shadows and highlights; 
this example is just to illustrate how a steeper curve 
increases contrast).  

Conversely, we can also reduce contrast in our 
image, by flattening the curve like this:

Here we’ve taken the pure blacks (along the 
horizontal input axis) and changed them to a lighter 
value (along the vertical output axis), and done the 
same by lowering the output of the highlight areas 
in the image. To adjust the curve in this way, you 
can simply click on the little black endpoints (called 
“anchor points”) on the curve line, and move them to 
where you would like them to be. So by flattening a 
curve, we are reducing contrast. Give it a try on a photo 
and see the results. Try pushing it further, and making 
a completely flat horizontal line for your curve; notice 
what happens?

The important thing to remember is that increasing 
the steepness of the curve will increase the contrast of 
your image, and flattening the curve will decrease the 
contrast in your image. There’s one last bit of theory to 
look at, then we’ll jump into some real world examples 
and applications for adjusting contrast with curves.

Meet Your New Friend... The Histogram!
The easiest way to tell if your image is lacking 

contrast, is simply by looking at it! If you feel that it looks 
a little flat, you probably need to adjust the contrast 
in your image. However, another way of telling if your 
image is lacking proper contrast, is by looking at the 
image histogram. The histogram will become one of 
your best friends as we go through each tutorial, to the 
point where you may start looking at a real-life scene 
and imagine the histogram in your mind! 

So what is a histogram? An image histogram is a 
graphical representation of the distribution of tone 
frequencies in your image, ranging from the darks to 
the lights. Let’s have a look at an actual histogram to 
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see what that really means (in English!):

Knowing the histogram is a valuable tool in the 
Photoshop arsenal. A quick glance at the histogram 
can immediately tell us if there are certain areas of our 
image that require some processing. Thankfully, Adobe 
has given us a Histogram Palette which you can view 
by going to the menu: Window>Histogram

 
I will cover other uses of the histogram throughout 

our series on curves, but for the time being I’ll discuss 
the histogram with regards to image contrast. 

Let’s have a look at an example:

Here is our image, and the image histogram, as 
shown in the histogram palette:

Immediately we can see that this particular 
histogram doesn’t stretch across the entire frame 
horizontally. There is a “gap” of empty data on 
the histogram at either end (more so towards the 
highlights). This indicates that the range of tones in this 
image is not stretching across the available brightness 
values from 0 - 255. We can adjust the curve so that 
the values DO stretch more across the brightness 
values from 0 - 255, giving us brighter highlights, and 
darker shadows. That will mean there will be a greater 
difference between the light and dark values, resulting 
in what...? That’s right! More contrast! Let’s use the curve 
to bring those highlight values in the histogram, more 
towards 255, and the shadow values more towards 0, 
thereby brightening the highlights, and deepening 
the shadows. 

Looking at the curve we can see the histogram in 
light grey, in the background.

By sliding the 
white tab in towards 
the brightness values 
that our histogram is 
showing, makes the 
resulting output values 
brighter. Doing the 
same for the shadow 
values makes them 
darker, and this results 
in the histogram being 
re-drawn to cover the 

whole range of values between 0 - 255. Look at the 
histogram palette now:

The white vertical lines represent areas in the 
histogram that was “stretched” to cover the range of 
light values. Small thin lines like this will be acceptable 
and will not affect image quality when viewing 
on a screen or in print, however, if your resulting 
histogram has wide thick lines, this may indicate some 
posterization in your image. So now, with this steeper 
curve, we can look at our image and see that contrast 
is greatly improved:

This is a simple way of adjusting contrast based 
on the histogram data of your image. In many cases, 
stretching the light and dark values so that they cover 
the entire range of brightness will be enough to give 
your image perfect contrast. Now we’ll look at some 
practical applications of contrast with curves.
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When Enhancing Contrast, Always Change the Blend Mode!

Recall that when we are using curves to affect contrast, we are only concerned with lights and darks in the image. 
In order to make sure that we only affect the light and dark values (luminance), you will want to change the blend 
mode of your curve to “Luminosity.” The best way that I recommend for doing this, is by making a curves adjustment 
layer, rather than going to the menu: Image>Adjustments>Curves... By making your curve on an adjustment layer, 
you are not altering the data on your original image layer, and you can also double click on the curves adjustment 
layer anytime to make additional changes or refinements to your curve. This is called “Non-Destructive Editing,“ and 
it is good practice to always work in this manner. 

You can create a curves adjustment layer by clicking on the “Create new fill or adjustment layer” icon at the 
bottom of the layers palette (it looks like a circle, half black - half white). Since your curve is on a separate layer, you 
can easily change the blend mode of that layer in the layers palette from normal to “Luminosity.” You’ll notice that 
after you do this, your image colors revert to looking more natural. There are times that we will use curves to change 
color values, but not in the case of increasing contrast. 

Original Image Curves Adjustment, Blend Mode - Normal Curves Adjusted, Blend Mode - Luminosity

The above example illustrates the importance of changing the blend mode of the curve to Luminosity. The 
original image was flat, and could use some contrast enhancement. The middle image shows what happened 
when I made the appropriate adjustments with curves; However, leaving the curves adjustment layer in “Normal” 
blend mode boosted the blues in this image to the point where it appears to have a blue color cast throughout. By 
changing the blend mode to Luminosity as seen in the third image, we are able to see the contrast adjustment on 
just the luminance data of the image. Contrast is improved, and the image detail looks better overall.

On the next page, I’ll take you through some examples of contrast enhancement with curves for not only 
enhancing contrast, but for brightening or darkening images that require either, or how you can use a curve to 
increase contrast in just a particular area of your image. I’ll also show you the curve that was used so you can see 
where and how the changes were made.

Turn the page for a closer look...
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Some Examples of Contrast With Curves:

Brightening An Image: We’ve managed to capture a beautiful 
sunset in this image, however, in order to have properly exposed 
the sunset, we’ve sacrificed the exposure on the setting of the 
buildings below. As a result, they are a bit dark in the scene. With 
curves, this is a quick and easy fix! Create a curves adjustment layer 
and change the blend mode to Luminosity. Next, double click the 
layer to bring up the curve. The underlying histogram shows that 
the bulk of this image’s tones are in the shadow ranges, hence we 
might want to increase the brightness in these areas. Instead of 
dragging the black slider inwards, what I’ve done is left it alone 
(since the histogram reaches all the way over to the blacks with 

no gap). Instead, you can click 
on the curve and add an anchor 
point anywhere. In this case, I’ve 
added one in the shadow areas, 
and pulled it upwards to lighten 
those areas. I also added another 
anchor point higher up, to “fix” 
my highlight areas so they will 
not be affected by the curve. 
Doing this has increased the 
brightness of the shadows and 
midtones, thereby brightening 
up the buildings in the scene.

Before

After

Before After

The result of adding an anchor point in the 
midtones region, and pulling it downwards 
effectively darkens the tones of the image. Notice 
the steeper curve equals more contrast.

Darkening An Image: You can see in the above image, that the photograph is slightly overexposed, and is lacking 
contrast. By now, you should be thinking that this needs a steeper curve! After adding the curves adjustment layer 
and changing the blend mode to Luminosity, the histogram showed me a couple things. First, the shadow range 
of the histogram was not stretching all the way over to the black side (0 value of light). Also, the histogram shows 
the bulk of the tonal data is in the midtone levels of this image, and those levels were quite high (hence a bright 
image). Knowing this, I moved the black slider inwards until it met with the histogram data, effectively darkening my 
shadows making them more rich. Also, I added an anchor point in the midtone area of the curve, and pulled it down 
slightly. This darkened the tones in those regions, and brought down some of the brightness in the image. Having 
a look at the final result on the right, we can see that there is an improvement in the overall contrast, and the image 
has been suitably darkened. Good job curves!
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Let’s have a look at a more complex example of 
what you can accomplish with curves. Let’s say you 
have an image, and you want to boost the contrast in 
a particular section of that image. Taking a look at the 
example to the left (Fig 1.1), we can see that the image 
doesn’t initially appear to have horrible contrast, 
although a slight boost would help. But let’s say that I 
want to really boost the contrast in the wooden planks, 
and make them really “pop” out of the scene. You can 
change the brightness levels of just certain areas of 
your image within the curves dialog box. 

With the curves dialog box open, you’ll notice 
that if you hover the mouse over your image, you’ll 
see the familiar eyedropper tool. If you hover over a 
certain area, you can click and hold the mouse button 
down, and as you continue to move the mouse around, 
you’ll notice a circle shape moving about along your 
curve line. This indicates the region of the curve that 
would affect the area you are click-dragging in. When 
I click-dragged the mouse over the wooden planks 
in this image, this is where the circle showed up on 
my curve, indicating which area of the curve would 
affect this brightness region of my image (Fig 1.2). I 
have illustrated the range of where the little circle was 
showing up as I dragged around the wooden planks, as 
shown by the red elliptical area here on the curve. I can 
now add anchor points on either size of this area of the 
curve (as shown in Fig 1.3 - anchor points # 1 and 2), 
and by dragging the lower one down (1), and the upper 
one up (2), I can increase the steepness of the curve in 
this area alone. However, I’ll also want to add another 
anchor point somewhere around the highlights region 
(3), so I don’t affect those areas. Lastly, in looking at the 
histogram, I can see that it doesn’t stretch all the way 
over to the right, so I can pull the highlights area of the 
curve inwards (4) to fix that. Here’s a look at the final 
curve I made, and the resulting image. The wooden 
planks really pop now! 

1

2

3

4

Fig 1.1 Original Image

Fig 1.2 Range of data shown by click-dragging in photo.

Fig 1.3 Curve shows selective saturation boost in particular areas.Final Image, Contrast Adjusted.
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The S-Curve:
You’ve probably heard the term at one point or 

another, “draw an s-curve.” We’ll finish up this section 
on curves and contrast by taking a brief look at the s-
curve and it’s function.

An s-curve is a quick and easy way to increase 
contrast (in most cases, quite nicely) in your image in 
a matter of seconds. You basically leave the highlight 
and shadow endpoint values where they are (unless 
your histogram “suggests” you should pull them in a 
little, and you add anchor points in the general areas of 
shadows and highlights. Then, simply pull the shadows 
anchor point downwards, and pull the highlights one 
upwards. This will keep the midtone levels of your 
image relatively unchanged, but overall contrast will 
be an improvement (in most cases). 

Here’s an example of a typical s-curve:

You can see the shape of it resembles the letter “S” 
hence the name! The amount of which you increase 
or decrease the steepness of the curve will determine 
how much or how little contrast you are adding to your 
image. 

I’d like to thank all of you (who made it through 
this!) for joining me on this in depth look at curves and 
contrast. I hope you have found some of the theory and 
tips to be useful in your work. I also hope this lesson 
has given you a greater understanding of curves and 
their usefulness. So be afraid no more, and open the 
curves dialog box, shake hands with your histogram, 
and have fun with the editing!

Next Issue...

We’ll examine:
Color Correction and
Color Cast Removal

with Curves!
 

How to go from this:

to this:

In our continuing series on 
curves, you’ll learn how to 
control color in addition to 

contrast control! 
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Actions in Action!
You’ve probably heard all about Photoshop® Actions by now, and maybe even 
downloaded a few. In this series, I’ll show you how you can create your own 
useful actions to automate those repetitive tasks. In this issue, we’ll go through 
the process of creating an adjustable “blurred” image frame.

BLURRED FRAME ACTION - BY DAVE SEERAM

Here’s a quick and easy method with which you 
can spruce up your images and display them 
nicely. We’re going to create a cool frame for an 

image, using a blurred version of the same image as 
the background and frame. Let’s go!

Step 1: 

Open an Image to work with!

Step 2: 

Open you Actions Palette (Window>Actions...)
You may want to create a new folder to store your 
actions in. In this case, create a new Actions Set by 
clicking on the little folder icon at the bottom of the 
Actions palette (Create New Set), and name this set 
“Frames.” Next, click on the “Create new Action” icon 
just to the right of that folder icon, and name this 
Action “Blur Frame.”

Step 3: 

Begin the Action recording process by clicking on the 
little “record” button at the bottom of the Actions 

palette, as shown here:
 

Step 4: 

The very first thing I do when creating Actions, is to 
automatically create a duplicate image to work on. 
That way, if I make any mistakes or accidently save the 
file, I won’t be saving over the original image. Do this 
by going to the menu: Image>Duplicate...

You can name the image anything you would like, or 
leave it as the default name that appears. You should 
immediately notice the step you just did has now been 
recorded in the actions palette! There’s still a few more 
steps to go, but we’re on the way!

Step 5:

Duplicate the background layer by clicking the 
shortcut “Control-J.” (Command-J on Mac) On this 
new duplicated layer, click “Control-T” (Command-T 
on Mac) to bring up the Transform Tool. At the top of 
your screen, you’ll see some options, one of which is 
the Width and Height percentages with a little chain 
icon in between them. Click on the chain icon to “link” 
the width and height ratios together, then change one 
of them (either one) to 75%. If the “link” icon is clicked, 
both the width and height of the image should have 
been resized to 75% or it’s original size. Next, go to the 
layer styles menu (Layer>Layer Styles...) and choose 
Drop Shadow, changing only the values of:
Angle: 135, Distance: 10, Spread: 0, Size: 50

With the layer styles still open, click on the layer style 
called “Stroke” at the bottom of the layer styles dialog 
box. Change the stroke size to 3 pixels, and click on the 
color box to change the color to black.
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Step 6: 

You’re almost there! Click on the background layer to 
make it the active layer in your layers palette. Next, go 
to Filter>Blur>Gaussian Blur... and choose a radius of 25 
(or smaller for low res images). You’ll want to be able to 
adjust this value at a later time, so click on the “Toggle 
Dialog On/Off” icon for that step in the recording in 
the Actions palette as shown to the right here:

That’s it! Stop the Action recording by clicking on the 
stop icon at the bottom of the Actions palette. 
   

You now have an Action that you can use over and over again! You’ll notice when you run the Action on a new image, 
the Action will stop and pop up the Gaussian Blur dialog box when it reaches that step. This is why we turned the 
dialog option “on” in the Action. This way, you can adjust the amount of blur to suit your individual images as you see 
fit! Additionally, you still have control over the stroke and drop shadow of the upper layer too. You can easily adjust 
those by double clicking on the layer styles inside the layer palette. Now you have a reusable frame Action with the 
ultimate control! Try adding additional elements to the action such as an artistic filter (instead of the Gaussian Blur), 
or maybe even darkening the background using Curves!

This article and all images contained are Copyright© and property of Dave Seeram. Any questions should be directed to the author. 
Dave Seeram is also the author of several free and premium Photoshop® Actions which can be found at:
http://www.photographybb.com/actions
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Member in the Spotlight
Each month, we’ll feature a “Spotlight” on one of our site’s forum members 
and tell you a little bit about who they are, what their photographic interests 
are, and display some of their work. This month, we’ll start by featuring the 
PhotographyBB Website’s creator and owner: Dave Seeram.

The funny thing is, I usually 
have a lot to say when it comes 
to photography and digital 

image editing, but when it came to 
writing this “spotlight” on myself, I 
was at a loss for words. For those of 
you who are interested in reading 
about me, I’ll give it a shot!

Tell us about yourself:

I’m just your average 32-
year old run of the mill guy, from 
Vancouver, Canada. I’ve been into 
digital photography for some time 
now, since I got my first digital 
camera (the Nikon Coolpix 880). 
Since that time I’ve owned several 
small point and shoot digital 
cameras, and I am currently the 
proud owner of a Pentax K10D DSLR 
camera for over a year now. Getting 
to know this camera and really play 
with its features has been a great 
experience, and has really helped to 
take my work to the next level. 

I would say that I’m more of a 

Photoshop guy than anything else 
though. I’ve had more experience 
in image editing than with 
photography, and I’ve had formal 
Photoshop schooling as well as 
many years of experience with 
the software. That being said, I am 
always learning new techniques 
from some of the very talented 
people I come across online. I love 
teaching folks all about image 
editing and how to get the most 
out of the software. I too was a 
beginner once, and I understand 
how overwhelming it can all be at 
first; hopefully I can help!

Photography-wise, I am really 
into landscape and architecture 
shots. I love urban landscapes, 
and I am starting to form a liking 
for candid people photos also. My 
passion lies in image processing, so 

most of my photography is geared 
towards the end result being either 
an artistic conversion, or an HDR 
(High Dynamic Range) conversion. 
I also love black and white, but 
that’s a skill I have yet to master! I 
recently went to Hong Kong, which 
was the first time I’ve ever been to 
a place so different from Canada, 
while having my camera with me. 
It was quite an experience, and I 
was able to capture some great 
shots while I was there. It gave me 
a lot of chances to experiment with 
shooting in RAW, which was still 
new to me at the time. Now, more 
than anything else, I prefer to shoot 
my photos in RAW format. 

Lastly, as most of you already 
know, I am also the creator and 
designer of the PhotographyBB 
Website and Forums, along with the 

FEATURE ON MEMBER:  DAVE SEERAM
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PhotographyBB Actions. It’s been a 
great journey creating the site, and 
I’ve met so many great people along 
the way. I started out with a limited 
knowledge of web programming, 
however, through the creation and 
evolution of the site I can say that 
I’ve learned quite a bit about web 
coding, and what it takes to be an 
administrator of such a site. I really 
geared the site towards beginners 
and intermediate users, but of 

course everyone is welcome there. 
There are some great people at all 
levels of photography and image 
editing experience, and everyone’s 
been very courteous and helpful.

What equipment do you use?

Camera wise, I have the Pentax 
K10D with 2 great lenses; the 16-
45mm, and the 50-200mm lenses 
both from Pentax. Because of my 

style of shooting, I tend to favor the 
16-45mm heavily. I hope to get their 
ultra-wide angle 12-24mm lens 
someday (that’s a hint to any folks 
feeling ultra-generous!). I also have 
a small Canon PowerShot SD630 
which has been a great point and 
shoot camera that can literally go 
anywhere with me.  On the software 
side, like I said, I am a Photoshop 
guy all the way. I have CS3, along 
with the original Adobe Creative 

A beautiful view of the city of Hong Kong from “The Peak” This photo was a combination of 3 images processed with Photomatix.

These are some images I shot while in Hong Kong. On the left: A street scene in Mongkok, and on the right: A large incense pot at a temple in Lantau
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Suite CS, Indesign CS3, Lightroom 
for processing RAW images (which 
I am still experimenting with), and a 
great piece of HDR software called 
Photomatix. 

What got you interested in 
photography?

That’s actually a very tough 
question to answer. I can’t pinpoint 
any particular event that sparked 
my interest in photography. I’ve 
always loved looking at photos and 
art, so perhaps that had something 
to do with it? My Dad and most 
of my uncles are really into 
photography, and I have a feeling 
some of that rubbed off on me; it’s 
just in my genes! I can say that as 
long as I can remember I’ve always 
admired graphic design and layouts 
of things like magazines, movie 
posters, and admiring different font 
styles. Wherever the interest came 
from, it’s a hobby that I love and will 
continue to pursue as long as I am 
able to work a camera, computer, 
and mouse!

Where do you see your work going 
from here?

I still consider myself a hobbyist, 
however, the site has grown and 
evolved into my business. Along 
with the creation of this magazine, 
I hope to continue expanding the 
website, adding to the growth of 
this magazine, and continuing in 
the pursuit of teaching and training 
others how to get more from the 
digital photography world. Last 
year, I had the honour of being 
asked to write for PBase Magazine, 
which has been one of the best 
experiences for me. Although they 
are on a short break at the moment, 
I am very eager to resume writing 
for them when the next issue comes 
back!

I will also be releasing more 
Photoshop® tutorials, along with 
some new tutorials for Elements® 
users starting next month. Some 
of you may have seen the new 

Photoshop® Actions Downloads 
page over at PhotographyBB, 
where there are several free actions, 
as well as some more complicated 
premium artistic effect actions too. 

I’d like to thank everyone for 
their support and assistance with 
the site and in the forums, and I 
welcome any new members to the 
site who would like to get to know 
us. Everyone at all levels is welcome 
to join, from beginners who can 
learn and grow, to the experts who 
love to share their knowledge. 
If you have any comments or 
questions, feel free to email me at: 
dave@photographybb.com
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Scrapbooking Tutorial Series
One of the best ways to showcase your digital photos or spruce up your web 
gallery is to build your own digital scrapbook. Our talented moderator, Victoria, 
begins this series by sharing some easy-to-use techniques in producing various 
effects and layouts for digital scrapbooking. 

HAPPY VALENTINE’S SCRAPBOOKING - BY VICTORIA SARGSYAN

Step 1:

Begin by creating a new document of any dimensions 
that you would like (use 300dpi resolution for print, or 
72dpi resolution for web use). Next, fill the background 
layer with any color of your choice. (In this case, pink or 
red would work well for Valentines!)

Step 2:

Double click the background layer in the layers palette 
and accept the name “Layer 0.” Duplicate this layer 
(Control-J on PC, Command-J on Mac). On the “Layer 0 
copy,” use the elliptical selection tool (or any selection 
tool) to make a cutout shape, and press “delete.” Next, 
press Control-D (PC) or Command-D (Mac) to deselect 
the area.

Step 3:

Open your “romantic photo,” and go to the menu: 
Select>All, then menu: Edit>Copy. Go back to your 
original document, click on Layer 0 to make it active, 
and click Control-V (PC) or Command-V (Mac) to paste  
your photo in between your two layers. You should see 
your photo through the selection cutout you made 
earlier. Click Control-T (PC) or Command-T (Mac) to 
resize and reposition your photo in the cutout area. 
Hint: You can hold the shift key down while dragging 
the corner anchor points to resize the photo and keep 
the aspect ratio constant.
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Step 4:

Click on the “Layer 0 copy” to make it active in your 
layers palette. Add a layer style by going to the menu: 
Layer>Layer Style... Try adding a stroke to the layer 
(you can change the stroke color and weight), or try 
other effects such as bevel/emboss, drop shadow, or 
outer glow. Experiment with multiple effects based on 
your preferences.

Step 5:

As in step 3, open a clip art illustration or graphic. Go to 
the menu: Select>All, then Edit>Copy. Go back to your 
image (Layer 0 copy should still be active), and paste 
the clip art onto your image as before. You can resize 
and reposition the clip art as described in step 3 also. 
If your clip art has a white background you can use the 
magic wand tool by clicking the white area, and then 
pressing delete to erase it easily.

Step 6:

Using the horizontal type tool, add some text to 
personalize your image. Click Control-T (PC) or 
Command-T (Mac) to rotate or resize your text to your 
liking. You can even add a layer style to your text as 
described in step 4. You’re finished!

The final result! You can even experiment by using 
textured backgrounds, or even other images as 
backgrounds instead of solid colors. Have fun!

Victoria is a member of NAPP (National Association of Photoshop Professionals) and is a talented graphic artist and 
web designer with over 15 years professional experience. To see more from Victoria, visit her website where you can 
check out her galleries and additional tutorials at:
http://www.viktoriyaimage.com
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Would You Like 
to Contribute?

We are looking for 
talented individuals 

who would like to 
expand their portfolios 

by volunteering to 
contribute articles to 

this e-magazine! If you 
are interested, we’d 

love to hear from you.

Topics of Interest are:

- Photography on Location
- Photoshop Tutorials
- Hardware / Software Reviews
- Camera Equipment
- Member Spotlight
- anything you’d like to share!

To become either a regular 
contributing author, or even 
just for a one-time article, 
please email us at: 
magazine@photographybb.com

Introduce yourself, share your 
idea, and maybe we’ll see you 
in next month’s issue!

Step into the Spotlight!
Would you like to be featured in the PhotographyBB 
Online Spotlight on Member section? If so, please let 
us know at: magazine@photographybb.com

We’ll feature your photos, a small biography and write-
up about you, as well as links to your web gallery or 
photography related business. We all love photography 
and image editing, so let’s get to know each other!

Next Month’s Issue:
We’ve got some great stuff in store for next month’s 
issue of PhotographyBB Online Magazine. Next month 
we’ll continue our series on curves with an article on 
color correction with curves. We’ll also have some more 
Photoshop actions, tutorials, Scrapbooking tutorials, 
and another Member in the Spotlight. 

We’ll also continue our series of “Photography Around 
the World” as we take you on a photographer’s view of 
far away and exotic places which just might make you 
feel like you are actually there!

Additionally, there will be some new editions to the 
magazine with articles on stock photography agencies, 
and a new series on Photoshop Elements tutorials. So 
with all this exciting stuff going on, stay tuned for next 
month’s issue of the PhotographyBB Online Magazine!

Discounts for Readers:
Each month we will be featuring special discounts 
for various online offers, exclusively for readers of the 
PhotographyBB Online Magazine. This month, we’ll 
feature a discount on our Photoshop Actions, with a 
whopping 30% discount on any PhotographyBB Action! 
(Discount Code:  PBBMAG30 - Valid until March 11th, 
2008)

Thank you for reading the PhotographyBB Online 
Magazine. We hope  you enjoyed it, and we’d love to 
see you again next month. If you have any questions or 
comments for us regarding this magazine, please feel 
free to email us at:

magazine@photographybb.com

We would love to hear from you!


